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Mejoras
Mejoras en Civil 2025 (v1.1)

- Pre & Post Procesamiento

1.Mejoras en midas GSD

-Chequeo de preesfuerzo para secciones generales

-Múltiples materiales para secciones compuestas o para rehabilitación

2.CQC3 combinación direccional para el espectro de respuesta

3.Consideración de fuerzas en elementos Elastic/General Link para Moving Load Tracer

4.Vehículo “B-double” de acuerdo con AS 5100.7

5.Consideración de dos camiones para los mienbros de la subestrucura o link elásticos/generals según las cargas de vehículos AASHTO LRFD

6.Vehículo de fatiga de acuerdo con estándar IRC

7.Propiedades dependientes del tiempo de acuerdo con  SP/M/022 v 3.4, AS5100.5:2017(Amd 2:2024) y AS3600:2018(Amd 2)

8.Adición de la función de espectro de respuesta de acuerdo con DPT.1301/1302-61:2018 y Eurocode Malaysia NA

9.Adición de las secciones tipo H y Canal en la bases de datos según EN 10365

10.Adición de un nuevo espectro de diseño en la base de datos para el Artificial Earthquake Data Generator 

11.Adición de factores de escala para la rigidez de los elementos

- Diseño

12. Anexos del Eurocode 22 para diseño de concreto reforzado (RC) y preesforzado (PSC)

13. Diseño de concreto reforzado (RC Design) para miembros 1D vigas y columnas, elementos Plate Beam  y Plate Column de acuerdo con BS 5400

14. Diseño de concreto reforzado (RC Design) y acero (Steel Design) de acuerdo con CSA S6:19

15. Factores de modificación de respuesta por miembros y componentes de acuerdo con AASHTO LRFD

16. Adición de la opción “Long-term Section Property of Cracked Composite Section: Rebar Area/3” de acuerdo con AASHTO LRFD



Enhancements
Mejoras en CIVIL NX 2025 (v1.1)

- Se incluyen todas las actualizaciones escritas en las páginas anteriores, y

17. Mejoras en el rendimiento de las tablas de salida y en el diseño visual

18. Actualizaciones de la configuración predeterminada de la barra de herramientas personalizada 

19. Plug-in con Grasshopper

20. Excel Add-in con MCT

21. Funciones para importar y exportar en el menu de Load Combinations

22. Mejoras en la visualización del color de los elementos de los grupos estructurales
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1. Mejoras en midas GSD

 Apps > General Section Designer

• midas GSD soporta ahora la verificación de secciones de hormigón pretensado a través de curvas de interacción P-M, curvas Momento-Curvatura y verificación del Estado Límite Último
(ULS),asegurandounavalidacióncompletadeldiseño.

• midas GSD ahora permite la definición de múltiples materiales para la modelación de la rehabilitación de secciones transversales, proporcionando una mayor flexibilidad y funcionalidad para
el diseñoy análisisestructural.

midas GSD
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2. CQC3 combinación direccional para el espectro de respuesta

 Load > Dynamic Loads > RS Load Cases

• LareglaCQC3 se hadesarrolladoparaestimarel valormáximode la respuestacombinadadebidaa la aplicaciónsimultáneade los componentesprincipalesdel movimientodel terreno.

• El usuariodefine la relación (γ)entreel espectromenory el mayor,y el programaencuentrael ángulocríticoy proporcionalarespuestamáximaparacadacomponente.

Caso de carga modal espectral

Las respuestas debidas al movimiento vertical del 
terreno, rz no se incluyen en los resultados del CQC3.

Eje mayor, S1

1 y 2: ejes principales del movimiento del suelo

Eje menor, 
S2 = 0.3S1



6 / 26

Civil 2025 (v1.1)  Notas de LanzamientoCivil 2025 Pre & Post Procesamiento

3. Consideración de fuerzas en elementos Elastic/General Link para Moving Load Tracer

 Results > Analysis Result > Moving Tracer > Elastic Link Forces/Moments

 Results > Analysis Result > Moving Tracer > General Link Forces/Moments

• Los apoyosde los puentessuelensimularsecon linkselásticoso links generalespararepresentarla rigidezde los apoyos.

• Ahora,MovingLoadTracersoportaLinksElásticosy LinksGeneralesparaencontrar la posicióncríticade las cargas delvehículoy convertirlaencargas estáticas equivalentes.

Moving Load Tracer
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4. Vehículo “B-double” de acuerdo con AS 5100.7

 Load > Moving Load > Moving Load Code : Australia 

• Un vehículoB-doublees definidoen la Ley Nacionalde VehículosPesados(HVNL)como unacombinaciónformadapor un vehículode tracciónprincipalque arrastrados semirremolques.

• Ya está disponible en la base de datos para Queensland(QLD) and Victoria(VIC) el vehículo B-double. Más de dos vehículos B-double pueden ser cargados marcando la opción en el Moving
LoadAnalysiscontrol.

Casos de carga móvil Vehículos B-doubleMoving Load Analysis Control
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5. Consideración de dos camiones para los miembros de la subestructura o link elásticos/generales según las cargas de vehículos 
AASHTO LRFD

 Load > Moving Load > Lane Support > Lane Support All Forces/Moments

• Aunque AASHTO LRFD dice: “Para el momento negativo entre puntos de inflexión bajo una carga uniforme en todos los vanos, el 90 por ciento del efecto de dos camiones de diseño
combinado con el 90 por ciento del efecto de la carga del carril de diseño”, los componentes de fuerza distintos del momento negativo deben determinarse basándose en la regla de los dos
camiones en algunos proyectos. Ahora, es posible seleccionar elementos o enlaces para aplicar la regla de los dos camiones y obtener resultados máximos para todos los componentes de
fuerzaenel análisisde cargamóvil.

Moving Load Tracer
Lane Support

All Forces/Moments

Aplicación de dos camiones que da la fuerza axial 
máxima de la pila.
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6. Vehículo de fatiga de acuerdo con estándar IRC

 Load > Load Type > Moving Load > Moving Load Code > India

• Se ha añadidoel vehículode fatigaa la bibliotecade vehículosexistentede IRC 6 : Carga Estándarsegúnla últimaenmiendaa IRC : 6 Carga de FatigaCláusula204.6.

• Para la evaluación,el factorde impactose ha sustituidopor el impactode la rugosidadsuperficialen funcióndel tipo de superficie.
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6. Vehículo de fatiga de acuerdo con estándar IRC

 Load > Load Type > Moving Load > Moving Load Code > India

• Las definicionesde carril de tráfico incluyenahorauna casillade verificación“EJ” para especificar las ubicacionesde las juntasde dilatación.

• Para las secciones/detalles situadas a menos de 6,0 m de la junta de dilatación, la carga de fatiga obtenida como se indica más arriba se incrementará con un factor de amplificación
dinámica, Iej.
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7. Propiedades dependientes del tiempo de acuerdo con las últimas normas de Australia y Nueva Zelanda

 Properties > Time Dependent Material > Creep/Shrinkage

 Properties > Time Dependent Material > Comp. Strength

• Propiedades dependientes del tiempo (Retracción, flujo plástico y Resistencia a la compresión) de acuerdo con las actualizaciones de los siguientes standards de Australia y Nueva Zelanda:
SP/M/022v 3.4, AS5100.5:2017(Amd2:2024)y AS3600:2018(Amd2).

Retracción y flujo plástico Resistencia a la compresión
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8. Adición de la función de espectro de respuesta de acuerdo con DPT.1301/1302-61:2018 y Eurocode Malaysia NA

 Load > Dynamic Loads > RS Functions

• Se añadenlos espectrosde diseñoparalas especificacionesde Tailandia(DPT.1301/1302-61:2018)y el anexonacionalmalasiodelEurocódigo.

Espectro de diseño DPT1301/1302-61 Función de espectro de respuestaEspectro de diseño MY EN 1998
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10. Adición de una nuevo espectro de diseño en la base de datos para el Artificial Earthquake Data Generator

 Tools > Data Generator > Artificial Earthquake

• AGS (Artificial Data Generation System for windows) extrae el terremoto artificial y el espectro de respuesta de diseño utilizando el espectro de diseño de cada norma. Se han añadido los
siguientes espectros de diseño: Taiwán (2022), IS1938(2016), NSR-10, P100-1(2013), NTC 2018, DBWH-LRFD BSDS(2013), AS 5100.2(2017), IRC:SP:114-2018, KBC(2016), China (GB/T 51408-
2021),China(JTG/T2231-01-2020),China(GB50011-2019),China(CJJ166-2011), Japón(Bridge2017), Japón(Bridge2012).

Base de datos de espectros

Sismo artificial (Conversión del espectro de respuesta)

Sismos artificiales (Conversión de aceleraciones en análisis TH)
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11. Adición de factores de escala para la rigidez de los elementos

 Properties > Section Manager > Element Stiffness Scale Factor

• Aplique factores de escala a los elementos lineales de la sección transversal (Truss, Tension-only, Compression-only, Cable, Gap, Hook & Beam Elements). La rigidez específica puede
reducirse,como en el caso de que la rigideza flexiónde las vigas en la regiónde momentonegativorequieraunareducciónparareflejar las secciones de hormigónagrietadas.

Factor de escala de rigidez
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12. Anexos del Eurocode 22 para diseño de concreto reforzado (RC) y preesforzado (PSC)

 Design > RC Design > Design Code Option

 Design > PSC Design > Design Code Option

• El programa soporta los anexos nacionales para el diseño de CR y PSC de los 22 países siguientes: Alemania, Austria, Bélgica, Chipre, Dinamarca, Eslovaquia, Eslovenia, España, Finlandia,
Francia,Grecia, Irlanda,Italia,Luxemburgo,Noruega,PaísesBajos, Polonia,ReinoUnido, RepúblicaCheca, Rumanía,Singapur y Suecia.

Código de diseño de concreto Código de diseño PSC
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13. Diseño de concreto reforzado (RC Design) para miembros 1D vigas y columnas, elementos Plate Beam  Column de acuerdo con 
BS 5400

 Design > RC Design > RC Code Design > Beam/Column Design

• El diseñoy la comprobaçiónde elementostipo lineade concretoreforzadode acuerdocon BS 5400 fueron introducidosen midas.

• Esta característicapuede aplicarsea pilareso vigas de concretoreforzado

Tabla de resultados de diseño Reportes detallados
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13. Diseño de concreto reforzado (RC Design) para miembros 1D vigas y columnas, elementos Plate Beam  Column de acuerdo con BS 
5400

 Design > RC Design > RC Code Design > Plate Beam/Column Design

• El diseñoy la comprobaciónde elementosde placade concretoreforzado segúnBS 5400 se han introducidorecientementeen midas.

• Estafunciónpuede aplicarsea alcantarillas,murosde pilareso losasen losque las tensionesse distribuyenen un solosentido..

Resumen de diseño de elementos plate Resultados de diseño de elementos Plate Beam/Column
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14. Diseño de concreto reforzado (RC Design) y acero (Steel Design) de acuerdo con CSA S6:19

 Design > RC Design > Design Code Option

• El cálculode los elementosde hormigónarmadoy de acerose ha actualizadoconformea CSA S6: 19.

 Design > Steel Design > Design Code Option

Reporte de diseño de aceroResumen diseño de concreto reforzado
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15. Factores de modificación de respuesta por miembros y componentes de acuerdo con AASHTO LRFD

 Design > RC Design > Design Parameters >  Response Modification Factor (R)

• Los efectos de las fuerzas de cálculo sísmico para las subestructuras se determinarán dividiendo los efectos de las fuerzas resultantes del análisis elástico por el factor de modificación de la
respuestaadecuado,R.

• En la versión anterior, sólo podía aplicarse un único factor de modificación de la respuesta. Sin embargo, la versión actual permite la aplicación de factores de modificación de respuesta
basadosen tipos de subestructurasy componentesde carga.

• Códigoaplicable:AASHTO-LRFD

Factor de modificación del 
espectro de respuesta

Tabla del factor de modificación
del espectro de respuesta
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16. Adición de la opción “Long-term Section Property of Cracked Composite Section: Rebar Area/3” de acuerdo con AASHTO LRFD

 Design > Composite Design > Design Code Option

• En versionesanteriores, las propiedadesde sección a largoplazode la viga mixtasometidaa momentonegativose calculabancomo «Secciónde acero+ Long. Refuerzo/3».

• Ahora,se añade unaopción paradeterminarlas propiedadesde la sección como «Sección de acero+ RefuerzoLong.».

Opciones de Código de diseño para secciones
compuestas de acero-concreto

Reporte de Diseño
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Actualizaciones en CIVIL NX 
2025 (v1.1)
Fecha de lanzamiento: Dic. 2024

Versión : CIVIL NX 2025 (v1.1)

*Las actualizaciones comunes de Civil 2025 
(v1.1) no figuran en este documento. 
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17. Mejoras en el rendimiento de las tablas de salida y en el diseño visual

• En MIDAS CivilNX 2025,se hamejoradoel tiempode procesamientode latablade salida, consiguiendouna reducciónde aproximadamenteel 30% en comparacióncon MIDAS Civil2025.

• Además, el esquemade coloresde latablase haactualizadoparaalinearsecon el nuevomarcode diseñode CivilNX, mejorandola coherenciavisualy laexperienciadel usuario.

CIVIL NX 2025 Actualizaciones

Modelo de 
prueba Tipo de tabla midas Civil

(sec)
MIDAS CIVIL NX

(sec) Taza de reducción(%)

Modelo 1
Plate forces/moments 198.81 133.95 -0.33

Plane-Stress/Plate Stresses_Plate Force 19.92 12.93 -0.35
Plane-Stress/Plate Stresses_Plate Stress 48.04 31.38 -0.35

Modelo 2
Beam Forces/Moments 12.76 8.31 -0.35

Beam Forces/Moments_View by Max Value 1258.93 93.15 -0.93

Tabla de propiedades de secciones Cuadro de diálogo de combinaciones de carga
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18. Actualizaciones de la configuración predeterminada de la barra de herramientas personalizada 
• Los iconos predeterminados de la barra de herramientas personalizada y de la barra de herramientas vertical se han actualizado para alinearse con los utilizados en la versión anterior de

midasCivil, loque garantizauna experienciade usuariocoherente.

CIVIL NX 2025 Actualizaciones

CIVIL NX 2024 (v1.1) CIVIL NX 2025 (v1.1)
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19. Plug-in con Grasshopper
• Los usuariospuedenconectar sus modelosde estructurasRhino+ Grasshoppercon MIDAS CIVIL NX utilizandoel complementoMIDAS GH a travésde Package Manager.

• MIDAS GH proporcionadesde componentesgeométricoshasta cargamóvil, etapasde construcción,base de datosde materialesy secciones de CIVIL NX y mucho más.

CIVIL NX 2025 Actualizaciones
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20. Excel Add-in con MCT
• Los usuarios pueden utilizar sus hojas de cálculo existentes utilizando MIDAS CONNECTOR. Este complemento analiza los datos mediante API, y es más flexible para crear, modificar y eliminar

componentes.

• Uso: 1. Selecciones todos los components y conectese con MCT_Parsing 2. Comando buscar 3. Dar un nombre 4. Seleccione una carpeta 5. Pulse el botón Añadir a carpeta, y 6. Pulse el botón
All MXT Export.

CIVIL NX 2025 Actualizaciones
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21. Funciones para importar y exportar en el menu de Load Combinations

 Results > Load Combinations

• En la versión anterior, los datos de las combinaciones de carga podían importarse en formato *.lcb, mientras que se exportaban en formato *.lcp. La diferencia de formatos de archivo y
estructurasentre las funcionesde importacióny exportacióndificultabalageneraciónde combinacionesde cargafueradelcuadrode diálogo.

• En la últimaversión, los usuariospueden importary exportarcombinacionesde cargaen un formatouniformede MS Excel, lo que mejorala facilidadde uso y la eficaciadel flujode trabajo.

CIVIL NX 2025 Actualizaciones

https://midastech.atlas
sian.net/wiki/spaces/M
SD/pages/71605496/-
+Make+Load+Combinat
ion+Sheet

Cuadro de dialogo de combinaciones de carga

Formato de Excel de combinaciones de carga
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22. Mejoras en la visualización del color de los elementos de los grupos estructurales

 View > Display > Display Option

• En la versión anterior, cuando la opción Color del elemento estaba configurada para mostrar Colores de grupo estructural, los elementos pertenecientes a más de dos grupos estructurales 
se mostraban con un único color etiquetado como Designación duplicada. Esto ocurría a menudo en modelos que contenían etapas de construcción o datos de carga en movimiento, donde 
los elementos eran comúnmente asignados a múltiples grupos estructurales. En la nueva versión, los elementos asignados a más de dos grupos estructurales se mostrarán ahora en función 
de la siguiente prioridad:

• Prioridad 1: El grupo estructural con el menor número de elementos entre los grupos estructurales asignados.

• Prioridad 2: El grupo estructural que figura en primer lugar en el orden de los grupos estructurales.

Esta mejora garantiza una visualización más clara y una mejor distinción entre las asignaciones de grupos estructurales que se solapan.

CIVIL NX 2025 Actualizaciones

Cuadro de opciones de visualización
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